
WinScribe TM
Welcome to WinScribe! WinScribe is a comprehensive resource management tool for Pastors, academic
theologians and Bible College or Seminary students. WinScribe eases the task of filing and retrieving 
important information. Special indexing and high speed search capabilities make it easy for you to find 
any word or combination of words, no matter where you originally filed it! 
The beauty of WinScribe is that - unlike all other filing systems - you don't have to know how you will use 
something when you file it; and you certainly don't have to know where to look for an item you filed long 
ago! Gone forever are the days of grueling searches that make you pick the file and the fields to search. 
You don't tell WinScribe how or where to search for things. You simply tell WinScribe what you want and it
handles the rest for you! 

WinScribe(tm). Copyright 1992, 1993. All Rights Reserved. L. E. Brown, Jr. WinScribe(tm) is not Freeware! It 
is protected by Federal copyright laws. If you use WinScribe(tm), you must pay for it! 

Help Topics 

Basic Operations
Files
Finding Things
Glossary
Printing
Credits



Basic Operations 

The best way to become familiar with WinScribe is to experiment with the menu system and the 
command buttons! 

WinScribe(tm) operations can generally be accomplished in several different ways. Accelerator keys will 
be the means of choice for touch typists because they can accomplish most tasks from the keyboard. 
Command buttons are displayed across the bottom of each window and facilitate rapid record navigation
and manipulation with a click of the mouse. Menu selections organize WinScribe's operations into groups
for File, Editing, Record and Reports. Finally, many of the operations can be accomplished by clicking on 
a tool bar button. 

Basic Operations Help Topics

Command Buttons
Menus
Tool Bar
Working with Text



Command Buttons 

Command buttons move through the records in the active file. Touch typists will appreciate the 
accelerator keys that perform the same actions as the command buttons, allowing you to keep your 
fingers on 'home row'! 

        Previous Record F7, Alt+P 
Dipslays the previous record in the active window. If the first record for that file is already displayed, the 
last record is displayed. 

        Next Record  F8, Alt+N 
Dipslays the next record in the active window. If the last record for that file is already displayed, the first 
record is displayed. 

        First Record  Ctrl+F7, Alt+F 

Dipslays the first record in the active window. 

        Last Record Ctrl+F8, Alt+L 

Dipslays the last record in the active window. 

        Add A Record  Alt+A 
Adds a blank record to the current file. You can then fill in the fieldsFLD of the blank record with with new 
information 

        Delete a Record Alt+D 
Removes the current record from the data file in the active window. Be careful with this button, because 
once you've deleted a record, it's gone for good! The only way to recover the record is to have a back-up 
copy of your file. 

        Browsing the file Alt+B 
Clicking on this button will open a new window and display the current data file in a table form, similar to a
spreadsheet. This is handy for navigating around the data file to locate the record you want. 

        Searching Text Alt+S 

Begins WinScribe's Fast Text Search procedure. If text in the current record is selected, that text will be 
searched for in other files and records. See Fast Text Search.FtsForm



Record

A discrete set of data that describes one item in a file. In the library file a record contains all the data 
about a single book. 



Field

A discrete piece of information in the record. For example, the title field in the journal file contains 
information about the article in that record. 



Current Record

The current record is the one displayed in the active window. 



Menus 

Both the Main Window and the subordinate windows use the menu bar to present drop-down menus 
from which you may select a WinScribe activity. Menu selections are made by clicking the appropriate 
menu on the menu bar and then clicking the desired activity. See the example. 

Another method for making menu selections is to hold down the Alt key and press the key which 
corresponds to the underlined letter on the menu. 

The Main Window Menu 

The File Menu
The Help Menu

Subordinate Window Menus 

The File Menu
The Edit Menu
The Record Menu
The Window Menu



Main Window File Menu 

The File menu lets you open your files and manage the catalog of matched record lists. To open one of 
your files simply click the File menu and click on the file you want opened. The files also have 
accelerator keys that bypass the File menu and open the files directly. 

Books [F2] opens the Library file. 

Illustrations [F3] opens the Illustration file. 

Journals [F4] opens the Periodical file. 

Sermons [F5] opens the Sermon file. 

Files [F6] opens the Filing Cabinet. 

All [F9] opens all the files. 

Catalog opens the Catalog of matched lists. 

Exit [Ctrl+F4] Exits WinScribe and returns control to Program Manager. 



Main Window Help Menu 

WinScribe's help system provides both general and context sensitive help. 

See Also

Help
Using Help
About...
User...



Opens the WinScribe help system. 



Opens the WinScribe help system with context senstive help. 



Allows you to modify user settings and default fonts. 



Tells you what a wonderful program this is and who developed it! 



Child Window File Menu 

The File menu in child windows operates like the Main Window's File menu. You can open a file while 
working in another file by either using the File menu or by pressing the function key that opens the file 
you want. 

There are two exceptions: 

1. You cannot open the Catalog when any other file is open. 

2. Clicking Exit or pressing Ctrl+F4 only closes the active menu. Any other open files 
remain open. 



Child Window Edit Menu 

Selections in this menu manipulate selected text or let you rapidly search for and replace words in the 
current record. 

Copy - copies selected text to the Clipboard. 

Cut - deletes selected text and places it on the Clipboard. 

Paste-  inserts Clipboard text at the insertion point. 

Select All - selects all text in the active text box. 

Replace - finds and replaces text in the current record. 



Child Window File Menu 

The selections in this menu determine which record will be displayed in the active window and also 
enable you to add or delete records for the file displayed in the active window. 

Previous - displays previous record. Displays 1st record if last is currently shown. 

Next - displays the next record. Displays last record if 1st is currently shown. 

First - displays the first record in the active window. 

Last - displays the last record in the active window. 

Add - adds a blank record to the file displayed in the active window. 

Delete - deletes the current record in the active window. 

Browse - displays the active file in table form. 



Child Window File Menu 

The selections in this menu govern how the subordinate windows will be displayed. 

Cascade - stacks all open subordinate windows within the main window. 

Tile - tiles all open subordinate windows within the main window. 

Arrange - arranges the icons for all minimized subordinate windows. 

1 - and etc. makes the window selected form this menu the active window. 



Subordinate Window

A window within the main window. Subordinate windows display the library, journal, illustration, sermon 
and filing cabinet files. 



How to use Menus

1. Click File on the main window's menu bar. 

2. Click Sermons on the file menu. 

3. Click the Record menu on the menu bar. 

4. Click Next on the record menu. 

That's all there is to it! 



Toolbar 

The toolbar consists of a message box, several buttons and a couple of list boxes. The Box displays 
messages to keep you informed when lengthy procedures such as reindexing are underway and 
reminders when you are processing marked records. 

The first group of buttons import, print and manipulate text in the active record. The import button permits
you to import any disk file into the current field. The print button allows you to print the current record. 
The cut, copy and paste buttons work with the Clipboard and selected text. The last button activates the 
help system.

The next group of controls consists of three buttons bracketed by two list boxes and a final button. These 
controls let you set the default values for font, font attributes and point size. The font list box shows the 
fonts installed on your system. Opening the list and clicking on a font changes the display to the selected 
font. Three buttons in the middle control Bold, Italic and Underlining. Clicking these buttons toggles font 
attributes off and on. The second list box allows you to size text between six and fourteen points. The final
toolbutton lets you change the default values. Clicking this button saves the current font and font 
attributes as the new default values. 



Import Button

Clicking this button permits you to browse through your disk files and select one to import into the active 
text box. 



Print Button

Clicking this button prints the current record in the active window. 



Cut

Clicking this button deletes selected text and places it on the Clipboard. 



Copy

Clicking this button copies selected text to the Clipboard. 



Paste

Clicking this button inserts text on the Clipboard at the cursor location. 



Help

Clicking this button opens the help file. 



Font Name

This list box allows you to select the font to use for displaying records.



Bold

This button toggles the bold font off and on in the active windows text boxes.



Italics

This button toggles the italics font off and on in the active windows text boxes.



Underline

This button toggles underlining off and on in the active windows text boxes.



Points

This button sets the point size for the active windows text boxes.



Reset Font Default

This button saves the current font settings in the active windows text boxes as the default setting for all 
windows. In order to apply the current settings to windows that are currently open but not active, you must
close and re-open them.



Working With Text 

WinScribe uses standard Windows accelerator keys to perform copy, cut and paste operations. 

Ctrl+X cuts selected text to the Clipboard. 

Ctrl+C copies selected text to the Clipboard. 

Ctrl+V pastes the Clipboard contents at the cursor location. 

Ctrl+Z Selects all text in the text box which has focus. 



Select Text

Text is selected by dragging the cursor over it while holding the left mouse button down. Selected text is 
distinguished with a different background color. Copy, cut and delete operations are performed on the 
entire block of selected text. Pasting from the Clipboard while text is selected replaces the selected text 
with the contents of the Clipboard. 



Clipboard

A temporary storage area in memory used to transfer data between applications. You can copy or cut text 
to the Clipboard and paste text from it. Pasted text is inserted at the insertion point. Copy or Cut    
operations replace the Clipboard's contents. Clipboard contents can be pasted as often as you like. 



Focus

Essentially a synonym for current or active; it technically refers to the text box or command button which 
will receive the results of the next keystroke. See also Current, Active. 



Accelerator Keys

A combination of keys that execute a command when pressed together. For example, pressing the 
Control and the F7 keys simultaneously moves to the first record in a data file. See also Command 
Buttons 



Command Buttons

Command buttons appear on the bottom of all WinScribe windows. Clicking a command button executes 
a command. 



Menu

A menu is a list of commands available in the active window. Commands appear in the menu bar and are 
activated by clicking on the menu name. 



Toolbar

The toolbar appears just beneath the menu bar in the main window. Clicking the buttons represent 
command options that are available in the active window. Toolbar



Click

The process of pressing and releasing a mouse button while the cursor is over a command button, menu 
or control. 



Fast Text Search 

The Fast Text Search Window is the command center for WinScribe's(tm) powerful search features. Here
you determine what to look for, which files to search and how the search should be conducted. Here's 
how to search your files for a word or words: 

1. On the active form    a word you want to search for. 

2. Click the Search button. The Search Dialog box appears

3. Modify the find string if you wish. You can retrieve previous searches by opening the 
Search History list box.Clicking a string in the list box changes the current search.

4. Check the file or files you want to search. 

5. Click the Begin button. 

WinScribe(tm) searches the selected files(s) to find records that match the targets in your find string. 
Whether or not a record is found depends upon the verification option. Suppose one of your files had a 
record that contained the words In the beginning God created.... WinScribe(tm) may or may not find this 
record, depending upon the verification method you use: At the beginning; at the end; as one target or 
as multiple targets. 

The Search History drop-down list tracks searches you've already performed. Clicking a selection in this 
list modifies the find string, making it easy to narrow or expand searches without typing! See the example
for further explanation. 



See Also 

Handling Matched Records
Catalog



Handling Matched Records 

Once a search has been completed the controls on the Toolbar change to handle the matched records 
your search has found. Managing these records is accomplished by clicking on the various buttons on the
toolbar. 

Previous - shows the previous matching record in the list. 

Next - shows the next matching record in the list. 

Cut - removes the current record from the list of matching records. 

Mark - marks the current record for saving in the permanent list. 

Print - prints the current record. 

Quit - abandons the matched list. Tip.

Save - adds the list of marked records to the catalog for later retrieval. 

You may also navigate through the list more rapidly by opening the drop-down list box and clicking the 
record you want displayed. Each item on the list points to a file and a record in that file. 

See Also 

Finding Things
Catalog
Naming Lists



Copying from a found record

You can copy text from a found record to the Clipboard, (select the text and use Ctrl+C. Then click the 
Quit button. You don't have to process all the matched records when you've found what you want! 



Naming Lists of Matched Records 

Once you have finished processing all of the records that were matched during a search operation, you 
may decide to save that list so that you can reconstruct the results of the search without actually 
performing the search. Naming the list will enter the list into the Catalog    and save the list in a disk file. 

This dialog box enables you to enter the name of the file in which this list will be stored on disk and a brief
description that will be entered in the catalog. The description should be detailed enough to remind you of
the search results when you are browsing through the catalog. 

The file name you assign should be between one and eight characters and should follow standard DOS 
file name procedures. The name may include the letters A-Z; a-z, the numerals 0-9 and the characters 
$&#@!%()~_-. It may not contain any spaces. 

See Also 

Catalog
Handling Matched Records
Finding Things



The Catalog 

The catalog maintains your lists of records that were found during search operations. This makes it 
possible to reconstruct the results of complex searches across multiple files without actually performing 
the search! 

The catalog is opened by selecting it from the File menu. The command buttons in the Catalog window 
perform the important operations. The catalog cannot be opened if any other files are open! 

See Also 

Handling Matched Records
Finding Things



Target String

The word or words that form the find string. For example, the find string "Jesus Christ" has two targets; 
the words Jesus and Christ. 



Verify Beginning

This verification type looks for matches at the beginning of words in your files. This would would find the 
hypothetical record if you had entered (for example) In, In the, In the beg as your find string. 



Verify End

This verification type looks for matches at the end of words in your files. This would find the hypothetical 
record if you had entered (for example) he, he beginning or od created as your find string. 



Verify And (Multiple)

This is the broadest verification type because it 'finds' all targets, regardless of where they appear. This 
verification type would find , , , , any other combination of letters that occur in the record. 



Verify One

string, this record would not be found; if beginning God was your find string, it would be. 



Find String

The string entered in the Search For text box. This is the word or words you want to look for in your files.



Check Box

Check boxes let you pick and chose from a group of related options. Selections are made by clicking a 
check box with the mouse. Selected check boxes have an 'X'; deselected check boxes are blank. 



Using the Search History List Box

In this example you will learn how to browse through the sample files to find everything dealing with 
Spiritual Gifts in first or second Corinthians. Follow these steps: 

1. Open the Sermon file by pushing F5. 

2. Select the word Corinthians in the first record. 

3. Click the Search button. 

4. When the Fast Text Search Window appears, check Files, Illustrations, Sermons and 
Journals for the scope of the search. 

5. Click the Begin button. 

6. When the search is complete a message box will tell you that thirty matching records 
have been found. Click the OK button. 

7. You've decided you want to narrow your search so you click the Quit button on the 
Toolbar. 

8. You're looking for Corinthians and gifts, so you select the word Gifts from the current 
record. Exclude the semi-colon. 

9. Click the Search button. 

10. Open the Search History list and click the word Corinthians. Voila! It is added to your 
find string! 

11. Make sure you've selected Files, Illustrations, Sermons and Journals as your scope 
search. 

12. Click the Begin button. 

13. This time the search will find six matching records. Click the OK button. 

14. To narrow the search further, click the Quit button on the Toolbar and then the Search 
button. 

15. Notice the words Gifts and Corinthians in the Find String. Add the word Spiritual. 

16. Press the ENTER key. 

17. Now only five records will be found. Click the OK and Quit buttons to quit! 

This is only a small example of the powerful search features in WinScribe! 

To print this example, Select File, Print Topic from the Help Window Menu. 



WinScribe Files 

WinScribe(tm) manages five different kinds of files: 

The Library 
Journals and Magazines
Illustrations
Sermons
The Filing Cabinet

Creating Your Own Files

Once you have learned how to use WinScribe by playing around with the sample files included with the 
program, you can start clean by deleting these files:

FILES.AGI and FILES.IA

LIBRARY.AGI and LIBRARY.IA

PERIODCL.AGI and PERIODCL.IA

SERMONS.AGI and SERMONS.IA

ILLUSTR.AGI and ILLUSTR.IA

The next time you start WinScribe and fire up one of the files, you will start fresh, with a clean slate.



The Pastor's Library 

Of making many books there is no end, and much study wearies the body. 
Ecclesiastes 12:12 

WinScribe makes it easy to catalog, track and browse every book in    your library. You can enter anything 
you want in any text box for search purposes, but the reports expect to find certain kinds of information in 
certain text boxes:

First Name - is for the author's first name. Tip.

MI - is for the author's middle initial. 

Last Name - is for the author's last name.  Tip.

Title - is for the name of this volume. Tip.

Publisher - is for the publisher's name and the place of publication. Tip.

Date - is for the date publication. 

Price - is for the amount you paid for this volume. Please Note.

ISBN/LC/DD - is used for the volume's catalog number. 

Loaned To - is used to record the name of the one who borrowed this volume. 

Loan Date - is used to record the date on which this volume was loaned. 

Keywords - is used to record any additional keywords you may wish to associate with this 
volume. You may include anything you wish, but searching is faster when you only include words 
which don't occur elsewhere in this record. Since WinScribe's Fast Text Search feature searches 
all fields in every record, you may find that the volume's title and notes are sufficient. Tips.

Notes - is used to record anything of interest regarding this volume. You should consider placing 
the book's table of contents as the first item in this field. Then, as you are browsing through your 
library file or your list of matched records, you can quickly determine whether or not you need to 
retrieve this volume from the shelf for further study. The theoretical limit for this field is 32,000 
characters, but searches will be much faster if you try to limit this field to about 4,000 characters - 
around four typewritten pages. 

See Also

Reports



If the volume has more than one author, enter the first author's entire name here. 



If the volume has more than one author, enter the full names of the other author or authors here. 



If this volume is part of a multi-volume set, be sure to include the title for the entire set here as well. If this 
is a reprint volume, or if this volume is an English translation of a foreign publication, be sure to include all
salient information in this text box. 



If you intend to use this information in bibliiographic references, be sure to use proper punctuation. 



This information is used to print a report of your library's holdings. This report should be periodically filed 
with your insurance company so that your library will be covered in case of fire or other disaster. 



The Illustration File 
As you do not know the path of the wind, or how the body is formed in a mother's womb, so you 
cannot understand the work of God, the Maker of all things. Ecclesiastes 11:5 

Experienced Bible teachers and preachers know that good illustrations are the lifeblood of effective 
biblical communication. WinScribe makes it easy to save and retrieve illustrations. WinScribe provides 
fields for Scripture references, the Source, cross-reference Keywords and the illustration's text. You can 
put anything you want in these fields, but if you intend to export these illustrations to Windows-based 
word processors through OLE or DDE services, or if you intend to print them, you should use these fields 
as follows:

Reference - is used record the verses for which you feel this illustration is appropriate. Tips.

Source - is used to record the source of this illustration. If there is the remotest possibility that you 
may publish this illustration some day, be sure to use this field! 

Keywords - is used to record any additional keywords you may wish to associate with this illustration. 
You may include anything you wish, but searching is faster when you only include words which don't 
occur elsewhere in this record. Since WinScribe's Fast Text Search feature searches all fields in every 
record, you may find that the volume's title and notes are sufficient.  Tips.

Illustration - is used for the text of the illustration itself. The theoretical limit to this field's length is 
32,000 characters, but searches will be much faster if you restrain yourself and try to keep the illustration 
to around four type-written pages! 



Success in finding illustrations by searching on Scripture references will largely depend upon your verse 
notation scheme. 

Abbreviations - Decide ahead of time how you will abbreviate Scripture references and stick with 
it. Searching for Romans will not find illustrations that contain the abbreviation Rom. One key decision 
will be the use Roman or Arabic numerals for 1 and 2 Samuel, etc. Searching for 2 Samuel 7 will not find 
records which contain II Samuel 7 as their only Scripture reference. (Of course, you could use both II 
Samuel and 2 Samuel; or even II 2 Samuel in the Scripture Reference field and cover all the bases!) 

Punctuation - Establish a pattern for punctuating Scripture references and stick with it. If you search for 
1 Corinthians 2:1-9 you will not find a record which contains 1 Corinthians 2: 1 - 9. When searching for 
words, exclude punctuation marks in your find string. 

Publication - If you anticipate using any of    your illustrations in published works you will save yourself 
a little bit of time later by using full names rather than abbreviations. Otherwise, you will have to edit your 
Scripture references in your for-release-document. 

Finding Illustrations



In my humble opinion 



Finding Illustrations 

The most arduous task the preacher faces is the relentless search for fresh, new illustrations. Although 
there are several computer programs that provide canned illustrations, none of them share compatible file
formats and all of them require that you specify what kind of search you're going to perform; and none of 
them is a true Windows program. If you own any of these illustration programs WinScribe import these 
programs' disk output. You may also want to experiment with the Windows Recorder to cut from these 
DOS based programs into WinScribe. But that still doesn't solve the problem of finding fresh illustrations. 

I'm no expert on the matter, but here's what I've found works for me. 

1. Reader's Digest and the Christian Reader will have lots of useful anecdotes and 
humorous stories. You'll have to figure out your own Scripture references for these. Leadership 
Journal has a regular column that features six to eight high quality illustrations each month. 

2. Daily devotionals, especially those published by Moody Press and Ligonier Ministries are 
laden with excellent illustrations that are already referenced to Biblical texts. IMHO Our Daily 
Bread is of mixed quality, often trite and the illustrations are frequently irrelevant to the text cited. 

3. Weekly news magazines such as Time, Newsweek and U.S. News and World Report 
have a page toward the front of each issue which presents compelling humor, memorable quotes 
and vignettes of important events for the previous week. Warning.

4. Read extensively outside your field of expertise. 

5. Ask your church members to help you find fresh illustrations. Many of them are voracious
readers who frequently stumble across gold mines of rich illustrations. After hearing your 
preaching for several months they will recognize what kinds of illustrations you should use! 

6. Don't copy Charles Swindoll, John MacArthur (Come to think of it, does he even use 
illustrations?), E. V. Hill or any other well known radio or TV preacher. Your people will have 
already heard it and you will look foolish. If you must use an illustration that you lifted from one of 
these personalities, be sure to give them credit. It's the right thing to do and it will increase your 
audience credibility! 

7. Always carry a 3x5 card in your pocket to write down illustrations you stumble across 
during the day. Simply having a couple of these cards in your pocket will increase your alertness 
for ideas. 

8. Set a personal goal of finding so many new illustrations per week. My personal goal is 
one illustration per day. 



These kinds of illustrations soon become dated. Use them quickly or don't use them at all. 



The Periodical Library 

Students, professors and pastoral practitioners need a simple but powerful way to keep track of 
significant (and not so significant!) journal articles, abstracts and book reviews! WinScribe(tm) to the 
rescue! 

Title - is used for the full title of the article or paper. 

Author(s) - is used for the author or authors of the article or paper. 

Citation - is used to record the bibliographic reference for this article or paper. 

Keywords - is used to record any additional keywords you may wish to associate with this 
article. You may include anything you wish, but searching is faster when you only include words 
which don't occur elsewhere in this record. Since WinScribe's Fast Text Search feature searches 
all fields in every record, you may find that the article's title and notes are sufficient.  Tips.

Notes - is used to record your notes about this journal article or paper. If this is a 
scholarly work you should consider putting the abstract or conclusion as the first item in this field. 
Later, when you browse your journal articles you can determine rather quickly whether or not you 
need to retrieve the article for further study. 

Ideas for the Future.



In the coming months I hope to provide a subscription service which provides montly updates to the 
Journal file. This monthly update would contain bibliographic references and complete abstracts from 
fifteen or twenty of the leading theological journals such as Journal of the Evangelical Theolgoical Society,
Bibliotheca Sacra, Interpretation, Catholic Biblical Quarterly, New Testament Abstracts, Old Testament 
Abstracts, Biblical Archaeology Review and others. If you have any suggestions as to which journals 
should be included, please let me know.

The purpose of such a subscription service will be to provide up-to-date references to those have no 
access to well-stocked theological libraries, and cannot afford the time or the expense of subscribing to 
and reading the many excellent publications. But, with this    subscription service in hand, you can order a 
hard copy of articles of interest from your local library through their Inter-Library Loan department. 



The Filing Cabinet 

Everything should be done in a fitting and orderly way 1 Corinthians 14:40 

Organizing a filing    system can be a make or break issue for many people. Should it be organized 
alphabetically? Topically? Numerically? What if you want to change your system later on? Stop worrying 
about it! The acid test of any filing system is the ability to locate things quickly. With WinScribe you can 
find anything, anywhere, no matter where you filed it. You can print out a index of your filing cabinet's 
contents for browsing; you can search your filing cabinet by file folder titles, by fo lder contents or by 
folder number. WinScribe doesn't care - you can use any system you wish! 

File Name - is used for the name or title that will appear on the folder's tab. 

File # - is assigned by WinScribe each time a new file folder is created. Using this number with 
your sermons, illustrations and other files makes it easy to find anything you have in your filing 
cabinet. Tip.

Keywords - is used for additional keywords you may wish to associate with this file. Searching is 
faster if you reserve this field for words that don't occur elsewhere in this record. Since 
WinScribe's Fast Text Search feature searches all fields in every record, you may find that the 
file's title and notes are sufficient. Tips.

File Contents - should be used to describe the various items - clippings, photocopies, 
handwritten notes, etc. - in the file folder. The descriptions should be detailed enough to be useful
in later searches. For example, if you have clipped an article entitled "Is Active Euthanasia a 
Moral Option?", and if you are searching for the words moral or euthanasia, the search would 
point you to this file folder if you simply put the article's title in the File Contents field! Tips.

The Go To Command button 
The Filing Cabinet window has one additional command button. Clicking on this button opens a small 
dialog box that lets you enter the number of a file folder. This convenient feature lets you jump directly to 
any file folder's record without paging or browsing endlessly thorugh the table to find the one you want. 

See Also 

Navigating the Filing Cabinet
Index of Files



Tips for the File Contents field

A little bit of forethought can save a lot of photocopying. Suppose, for example, that you want to file an 
article entitled "Sex, Marriage and Divorce." Which file folder would you put it in? The folder on 
marriage, the one on sex, or the one on divorce? It doesn't make any difference. Just include the whole 
title in the File Contents field of the lucky folder and it will be found if you are searching for one or more 
of those three words. 



How should file folders be stored?

You can store file folders in the filing cabinet in any way you want; it won't affect how quickly and easily 
you can find things with WinScribe. Storing them in numerical order avoids the need to shuffle lots of 
folders around when a drawer gets filled. Alphabetical storage requires you to move lots of folders in lots 
of drawers to maintain alphabetical order. Suppose you want to add a folder entitled FEMINISM, but the 
drawer is already full. You've got to move everything from G to Z in order to make room for one file folder. 



Tips for the File Folder's Keywords field

Suppose you are doing research on the occult. You use the words occult New Age Satanism demons 
for your find string. This search may overlook an article on the occult that you filed under CULTS. But, by 
adding the world occult to that file folder's Keyword field, the article would be found. 



Navigating the Filing Cabinet 

If someone else does your filing or typing for you, their job may be made easier if you tell 
them which file number an item should be filed in. Attaching a Post-it note to the article, clipping or copy 
being filed makes it easy for your typist to locate the appropriate record. Clicking the Go To button opens 
a dialog box in which the file number can be directly entered: 

Using the Go To feature creates a set consisting of only that record from the database, and the typist will 
not be able to move to another record until the SET button is clicked. This feature reduces the likelihood 
that the article will be filed in the wrong folder! 

The set is released and all records once again become visible when the SET button is clicked.

See Also

Index of Files



Sermons 

He taught as one who had authority, and not as their teachers of the law. Matthew 7:29 

WinScribe makes it easy to catalog your sermons for later examination. WinScribe(tm) stores information 
about each sermon's scripture references, title, cross-reference key words as well as data about when 
and where the sermon was preached. You can put anything you want in these fields, but we suggest you 
use them in the following manner:

Scripture Reference - is used record preaching text for this sermon. Tips.

Sermon Title - is used to record the title of this sermon, if it has one! 

Speaker - if this sermon was preached by someone else you should include the speaker's name 
here.  Future Ideas.

Church - can be used to record where this sermon was preached.  Tips.

Date - is used to record the date this sermon was last preached in the mm/dd/yy format. Tip.

Tape - is a logical field which accepts either a Y or an N. This flags those sermons you have on 
tape. 

File # - is used to remind you which file folder contains a hard copy of the sermon manuscript. 
Since you are a power user we know that you manuscript your sermons! Tip.

Keywords - is used to record additional keywords you may wish to associate with this sermon.  
Tips.

Manuscript - is used for the sermon's manuscript. You should consider placing the sermon's 
main idea and outline as the first items in this field. Then, when you are browsing through your 
sermon file or examining matched records, you can determine rather quickly whether or not you 
need to pull the hard copy from your filing cabinet. Tip. Limits.



If you use a Window's based word processor to develop your sermon manuscripts, you can Copy the 
manuscript while in your word procesor and then Paste the manuscript into this field! 

If you use a DOS based word process to develop sermon manuscripts, use WinScribe's Import button on 
the Toolbar to import the file into this field! 



If you don't have a copy of your filing cabinet index handy, you can still find the appropriate file folder for 
this sermon very easily. You can either open the Files window and browse the table, or you can search 
the files database, copy the file number to the Clipboard, return to this sermon and paste the file number. 



Someday I'll publish a program to manage a file named Sermons I Stole From Other Thieves! 



Those who travel extensively and preach in many different churches every year can use this field to make
sure they don't preach the same sermon in the same place twice! 



Terms like "Wow!" and "Magnificent" should be used sparingly. You may include anything you wish, but 
searching is faster when you only include words which don't occur elsewhere in this record. Since 
WinScribe's Fast Text Search feature searches all fields in every record, you may find that the sermon's 
title and manuscript notes are sufficient. 



The theoretical limit to this field is approximately 32,000 characters, but the Fast Text Search operations 
will be much faster if you limit this field to approximately 4,000 characters; about four type-written pages. 
On the other hand, if your sermon manuscripts typically run 32,000 characters you probably preach in a 
small church and can't afford a large hard drive so you'll be forced to economize your words in this field! 



This will help those who retread old sermons avoid recycling them too frequently! 
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Abstract 
A brief synopsis of a book or journal that outlines its central thesis and basic argument. 



Active 
The window or icon that is selected. Windows always applies keystrokes and commands to the active 
window. Active windows have a title bar colored to distinguish them from other windows. An active icon is 
distinguished by the color of its label. See also Current. 



Agility 
The database engine used to develop WinScribe. 



Apex 
Distributors of Agility/VB 



Catalog 
The Catalog manages lists of matched records from previous search operations. 



Control Menu

A menu that manipulates a window's placement, size and special settings. The command menu is 
activated by clicking the Control-menu box at the left of the Title Bar or by clicking once on an icon. 



Copyright

WinScribe(c), Copyright 1992, 1993. All Rights Reserved. L. E. Brown, Jr. 



Current

The text box which has the insertion point and will receive the next keystroke. The term also describes the
database file and the record displayed in the active window. See also Active. 



Default Font

The font that will automatically be used to display records on the screen. The default font can be changed
by the Toolbar buttons. 



Directory

Part of the organizational structure of your hard disk. A directory can contain files and subordinate 
directories. A directory tree is a graphical representation of directories and their relationships. 



Drop-down List Box 

A small window on the Toolbar that displays a list of choices. The list is opened by clicking the small arrow
on the right side. 



Fast Text Search 

A Dynamic Link Library that tokenizes strings into unique signatures that are stored in files for rapid 
searches. 



Field Length

Fields are limited to 32,000 characters. 



File

A collection of information or commands that has been stored on disk under a valid filename. A file can be
a document, an application, a picture or data. 



File Name

The name of a file. Windows uses MSDOS file naming conventions. 



Focus

The window, textbox or command button which will receive keyboard or mouse input. 



Font

The design of numerals, letters and characters as they appear on screen or on paper. Fonts usually come
in different sizes and styles. The font, font size and font style used to display records can be modified by 
the Toolbar buttons. 



Icon

A graphical representation of a window or an object in Windows. You reduce an application or objec to an 
icon by clicking the minimize button. You enlarge an icon into a window by double-clicking on it. See also 
Minimize. 



Illustration

An anecdote, joke or fact that clarifies the meaning of an ambiguous or abstract idea 



Index Applications 

Distributors of Fast Text Search for C/Windows. 



Insertion Point

The blinking vertical bar that indicates where text will be inserted from the Clipboard or the keyboard. 



Matched Record

Any record that contains words matching the targets in the find string. 



Minimize 

To reduce a window or an object to an icon by clicking on the minimize button or by selecting the minimize
command on the Control menu. See also Control Menu, Minimize Button. 



Minimize Button

The button with the down arrow on the right side of the Title Bar. 



Scope

The range of files that will be searched for targets in the find string. The scope is set in the Fast Text 
Search window. 



Verification

The manner in which records will be searched for matches: At the beginning of every word, at the end of 
every word, anywhere within any word or exact matches only 



WinScribe

The finest research and resource management tool for Pastors and academic theologians available 
anywhere 



Keyword Fields 

One of WinScribe's most flexible and powerful features is its abiltiy to quickly find any word in any file. 
The Keywords field harnesses this power by permitting you to organize your files according to any 
taxonomy you chose. 

For example, the keyword field might contain the words Commentary; Old Testament for all of your Old 
Testament commentaries. The Keyword field can then be used to distinguish one commentary genre from
another. Exegetical commentaries might have the word Exegetical in the Keyword field while other sorts 
of commentaries might have the words Devotional, Critical or Theological in this field. Note.

These suggestions for Keyword fields (or any field, for that matter) make it easier to find things: 

Consistency - Develop a consistent method of classifying things and stick with it. 

Abbreviations - Decide ahead of time whether and how you will abbreviate Scripture references 
and stick with it. If you use the One verification option, searching for Rom will not find records 
that contain only the word Romans. 

Punctuation - Establish a pattern for punctuating Scripture references and stick with it. If you 
search for 1 Corinthians 2:1-9 you will not find a record which contains 1 Corinthians 2: 1 - 9. 
When searching for words, exclude punctuation marks in your find string. 



Of course, these words could be entered in any field and the search results would be the same. Every 
volume in your library that contained the targets Old Testament    Exegetical Commentary would be 
found regardless of which field contained these words, and - depending upon the verification option used 
- regardless of what order the words are in. 



User Profile 

The first time you use WinScribe the program needs to gather a little information about you and about 
your computer system. The information you provide about yourself will be used in reports. Your selection 
of default font, font attributes and font size will be used to display your files and records. You will also tell 
WinScribe where on your computer's directory structure the WinScribe files will be stored. 

The following fields are mandatory 

Your Name
Your address
Your City, State and Zip Your home telephone number
The path to your files



File Path 

WinScribe needs to know where you will store your WinScribe files. By default they are installed in the 
WSCRIBE subdirectory with the WinScribe program files. They can be stored anywhere you like; you 
simply need to let WinScribe know where to find the files. 

To tell WinScribe where your files will be located you simply open the directory dialog box by clicking the 
Browse button in the lower left hand corner of the Installation window. Browse through your directory 
structure until you see files with the .AGI file extension. In particular you should look for SERMONS.AGI, 
FILES.AGI, PERIODCL.AGI, ILLUSTR.AGI - these are the files WinScribe works with. When you've 
located these files, simply click the Okay button. 



Credit Where Credit is Due! 

My help comes from the LORD, the Maker of heaven and earth. Psalm 121:2 

Portions of this program use the Fast Text Search Library for C/Windows, published by Index 
Applications, Inc.; San Antonio, Texas. 

The database engine for this program is Agility/VB, published by Apex Software Inc. 

My heartfelt thanks to technical support personnel everywhere who often rescued me in an hour of need. 
Thanks also to my beta testers who labored in tears as the program was developed, debugged and made
ready.



Filing Cabinet Index
The filing cabinet index is an alphabetized list of your files titles. The index makes it easy for you to 
manually search for a specific file in your filing cabinet. You can also print the index if you wish.

To view the index

1. Open the Files window (Press F6)

2. Open the Reports menu.

3. Click the Files Index selection.

The file index will be presented as a table in its own window. The file number is listed in the first 
column and the title of each file is listed in the second column. You can scroll through the list with 
the mouse or with the PgDn and PgUp keys.

To print the index



1. Complete Steps 1, 2 and 3 above.

2. Click the Print button.

3. The Page Setup Dialog box will appear.

4. Set the margins to your specifications

5. Click the Okay button to print the index.

To close the index

1. Click the Close button.



Printing Records and Reports
WinScribe will print both records and reports. It will print the current record in the active window, or it will 
print special reports for the Library and Filing Cabinet files.

To print a record, simply click the print icon on the toolbar  . 
To print a report, either the Library or the Filing Cabinet window must be active.

See Also

Printing Records



The Search Dialog Box
The search dialog box lets you specify which files to search and how the search is to be performed.



Printing Records
When you print a record, WinScribe lets you select which fields in the current record to print and select 
which margins you want printed.



 Scope

Check the files you want to search. Those that have the check box checked will be searched.



 Printer Setup

Clicking this button will invoke the Control Panels Printer Setup.



 Print Fields

Check the fields you want printed. Those that arent checked wont be printed.
This frames appearance will depend upon which file is current.



 Page Size

Select which page size you want the record printed to. Selecting custom will invoke the Page Setup 
Dialog box



Page Setup - Left Margin

The left margin is measured from the left edge of the page. Enter the number of inches you want for the 
left margin. You may use the decimal point to indicate fractions of an inch.



Page Setup - Right Margin

The right margin is measured from the right edge of the page. Enter the number of inches you want for 
the right margin. You may use the decimal point to indicate fractions of an inch.



Page Setup - Top Margin

The top margin is measured from the top edge of the page. Enter the number of inches you want for the 
top margin. You may use the decimal point to indicate fractions of an inch.



Page Setup - Bottom Margin

The bottom margin is measured from the bottom edge of the page. Enter the number of inches you want 
for the bottom margin. You may use the decimal point to indicate fractions of an inch.



Page Setup - Indent

The indent margin is applied only to the first line of each paragraph that you print. The number you enter 
in this box is added to the number entered in the Left Margin box. 

To indent the first line of each paragraph

Enter a number here. Thus, entering .5 would indent the first line 1/2 inch.

For hanging indents

Enter a negative number here, using the - key. Thus, entering -.5 would create an outdent of 1/2 
for the first line of each paragraph.



Search History

This list box keeps track of all previous searches during the current WinScribe session. To find a previous 
search text, click the arrow on the right end of this list box. Browse through the list until you find text you 
want and then click on it. It will become the new search text.



Library Reports
WinScribe will print a complete list of your holdings. including all salient bibliographic data needed to 
uniquely identify each volume. This report should be filed with your insurance agent from time to time to 
insure that any losses will be covered by your policy.

By itself this list does not prove that you actually own the volumes. An adjuster will want to see either 
sales receipts or a wide-angle photograph of your library. But this report will provide all of the details 
necessary to document the extent of your losses. When this report is submitted on a claim, when 
accompanied by receipts or photographs, you should be able to recover the entire amount to which you 
are entitled under you policy.



Page Setup
When you print standard reports, or when you select custom to print a record, the Page Setup Dialog box
appears. In this box you select your printer settings and then either print the report/record or cancel 
printing.



Open

Clicking this button opens the file highlighted in the file list box and reconstructs the list of matched 
records described in the description box.



Cancel

Clicking this button closes the catalog.



Help

Clicking this button provides context sensitive help.



Delete

Clicking this button deletes the file highlighted in the file list box.



File List

This list box allows you to select which file to open or delete.



Description

This contains the description of the file that is selected in the File List Box.



Registering WinScribe (TM)

WinScribe is Shareware - you are temporarily licensed to use this Shareware Version for thirty days. At 
the end of the thirty days you must either register your copy or delete the program from all of your disks 
and diskettes.

When you register WinScribe you receive

* Printed manual

* 30 Days free telephone support

* Full version with DDE links to WinWord

* 2,000 Indexed Illustrations!

* Free upgrade for the next version

* No Nag Screens

* The sense of wellbeing that comes from doing the right thing

To Register Print this form (File, Print Topic), fill it out and send it in.

WinScribe Registration

--------------------------------------------------------------------------------------------------------------------------
 [ Your Name ]

--------------------------------------------------------------------------------------------------------------------------
 [ Address ]

-----------------------------------------------------------------        -----------------------------------------------------
 [ City ]                                                          [ State ]              [ Zip Code ]              [ Where did you get WinScribe? ]

_________ - WinScribe Shareware Registration @ $ 50.00 ea. (US Funds)______



                                        Shipping and Handling 5.00

                                        Total ______

Indicate Diskette Size:

__________ 5 1/4                  ____________ 3 1/2

Make checks payable to:

L. E. Brown, Jr.
Mail your check and this form to:

WinScribe
% 120 Deer Trail Drive
Sedona, AZ 86336




